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Introduction

This Lab Manual provides the step by step procedure to complete two labs in the MASTERs 32075 IoT6 Class.

In Lab 1 we will open a TCP project, do some stack re-configuration and a connectivity check and in Lab 2 we will show an
Application integration for local access, using the example of a Vending machine. Finally in Lab 3 we will make an Application

integration for external access, using the example of a Weather Service.

Hardware Requirements

The following hardware is required:
e SAM E70 Xpained Ultra (Microchip Part Number: DM320113)
o http://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=dm320113

e Cat 5 Ethernet Patch Cable
e USB Male A to USB Male B Micro Cable



http://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=dm320007
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Software Requirements
The following software is required:
e Microchip MPLAB X IDE v5.20

o http://www.microchip.com/mplab

Microchip MPLAB XC32 Compiler v2.15
o http://www.microchip.com/mplab/compilers

Microchip MPLAB Harmony 3

o http://www.microchip.com/mplab/mplab-harmony

Microchip MPLAB Harmony Configuration (MHC) Tool Plugin v3.3.0.1

Tera Term v4.95



http://www.microchip.com/mplab
http://www.microchip.com/mplab/compilers
http://www.microchip.com/mplab/mplab-harmony

23075 loT6 Simplifying TCP/IP Applications with MPLAB® Harmony

Lab 1

Overview

Lab 1 will show you how to open an existing TCP/IP MPLAB Harmony 3 Project and using the MPLAB Harmony Configuration (MHC)
Tool. The project will incorporate basic TCP/IP functionality to allow the SAM E70 Xplained Ultra to connect to an Ethernet Network,
along with a simple application to flash a “Heartbeat” LED every 500ms. Once the project is generated and programmed onto the

development kit, you will use a number of techniques to validate that the PIC is connected to a network and determine its IP

Address. The concepts that will be covered in this lab include:

Open a SAM E70 MPLAB X Project
Configuring the MPLAB Harmony path
Configuring the TCP/IP Stack options, including:
o Network Configuration of the Host Name
o TCP/IP Services including Dynamic Host Configuration Protocol Client, ICMPv4 Server (for Ping testing) &
Announce Discovery Tool
o Bandwidth testing with “iperf”
Configuring the Harmony Console and Command Service for monitoring and control of the TCP/IP stack via a Terminal
Client running on a USB CDC Interface (Emulated RS232 COM Port).
Toggling the 10 Pin that drives USER_LEDO on the SAM E70 Xplained UltraSAM E70 Xplained Ultra
Using the Windows Command Line Ping Tool and the Microchip TCP/IP Discovery tools to test connectivity of your SAM
E70 Xplained UltraSAM E70 Xplained Ultra on the network
Use the Console and Command System to get help on available TCPIP Commands and execute a command to get

information about the network configuration.
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Lab Procedure

Starting MPLAB X IDE

1.1. Start MPLAB X IDE by double clicking on the MPLAB X IDE vv5.20.04 icon found on the Windows desktop.

MPLAB X IDE
v3.20

PEES DE o e Y T & (@ Howdo
Kit Window | Start Page | MPLAB X Store &
MCU Boards SAM E70 Xplained Ultra

& SAM E70 Xplained Ultra

The Microchip SAM E70 Xplained Ultra (DM320113) evaluation kit is a hardware
platform to evaluate the Microchip ATSAME70Q21B microcontroller. Supported by
Microchip Technology Inc. tools including Atmel Studio & MPLAB X integrated
development platforms. This evaluation kit is the first of its kind hardware platform
compatible with XPRO extensions, X32 Daughter Board (Bluetooth & Audio), Modular
Graphics (GFX) interface, Modular Ethernet PHY interface, mikroBUS, and includes an
on-board Embedded Debugger (EDBG).

¥ External Links

% SAM E70 Datasheet
@ SAM E Series Product page

¥ Extension @ MPLAB Harmony

OLED1 Xplained Pro » Kit Information
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Project Load, modify with MHC, Generate, build and run

1. Open Project by choosing File»Open Project... from the main menu and select lab1 project

"

¥4 Open Project @
, Look in: MASTERS i
- - - .
Recent ftems = | 23075 Project Mame:
[H- | h3 web_net_server_nvm_mpfs_freertos_labl
= | lab1
! © Bk | firmware Open Required Projects:
Fl= |sam_e70_xult_freertos.X
Desktop - G L RTIS
[+ | src
[H- | lab2
: - | lab3
[+ | Lab_Manuals
My Docum... _, scripts
- | wvm_server
A
Computer
Q& File name: C:\MASTERsS\23075\lab1\firmware\sam_e70_xult_freertos.X Open Project
Neswork  Files of type:  [project Folder z

2. Open Project Properties by choosing

a. File»Project Properties from the main menu

b. Or select with a right click the project node in the project windows and select at the bottom

History

. Properties -

c. Orselect the toolbox in the Dashboard

]

m_my\fs_freertos_lab1 - Dashboard = | APP_Tasks() - Navigator

= D

! i wetl_nEt_sewer_nvm_mpfs_freertns_latll
8 Project Type: Application - Configuration: sam_e70_xult_fre:

evice

-G ATSAME70Q21B
™ “- # Checksum: Blank, no code loaded

@ =@ Packs

“- @ CMSIS (5.0.1)

e B T R S T A

i@ SAME7Z0_DFP (3.0.10)
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d.
3. Select the XC32 Compiler v2.15

4. Select the SAME70 Xplained by clicking on the SN: Number

53 Project Properties - web_net_server_nvm_mpfs_freertos_labl

Categories:

General

File Inclusion/Exclusion
Conf: [sam_e70_xult_freertos]
EDBG

Loading

Libraries

Building

XC32 (Global Options)
- we32-8s

xC3Z-geoc
®C32-g++

xc32-Id

HC32-ar

S T S T S ]

LT S = R o

4 | n | »

’ Manage Configurations...

Configuration

Family: Device:
All Families v ATSAME70Q218 -
Supported Debug Header: Supported Plugin Board:
Mone | |None hd
Packs: Hardware Tool: Compiler Toolchain:
. Packs . ;I;k;:df 4 | | | Compiler Toolchains
£ SAMEZO_DFP || o o [=+ARM
o o PM3 __ | o ARM (v6.3.1) [c:\Program Fil
P -l 4.0.29 - Real ICE [=+X(C32 [Download Latest]
- CMSIS o Simulator =1XC32 (v2.15) [C:\Program Fil
- A @ X(C32 (v2.10) [C:\Program Fil

00 Snap

. Alternate Tools

-0 Powrer Debugger i
- |0 Microchip Kits
@ PKOB nano

E-o0 SAM E70 Xplained
RS\ ATML318607
~~@ Starter Kits (PKOB) ~
| 1 | b

(v2.10)
@ XC32 (v2.05) [C:\Program Fil
@ X(C32 (v1.44) [C:\Program Fil

(v1.42) [C:\Program Fil
: (v1.40) [C:\Program Fil
@ ¥C32 (v1.40) [C:\Program Fil

I T 3

*Tip: double click on serial number (SN) to use a friendly name (FN) instead.

| ok

][ Cancel ” Apply ]

5. Select from the Tools Menu the Harmony 3 Configurator

am_e70_xult_freertos

ram Window Help
B Embedded
j— Licenses

Packs

e CRILVINGOW |

» =  MPLAB® Harmonv 3 Framework Downloader
l ¥ Z7MPLAB® Harmony 3 Configurator l

el

Unlock
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6. Ensure the H3 Path is set to “C:\MASTERs\23075\h3\”

2 MPLAB Harmony Launcher @

Active Project Information:

Name: sam_e70_xult_freertos

Select an option to use for the launch paths for the MPLAB Harmony Framework tool suite:

(@) MPLAB Harmony Project Path - The framework path that is stored with this MPLAB Harmony project. Reconfigure Paths

Harmony Path: C:\MASTERS\23075\h3

() MPLABX Path - The framework path that is stored with MPLABX (configured through Tools->Options->Harmany)

Harmony Path: C:\microchip\h3

Default Launch Action: | Prompt For Path Selection (This... ¥ |

(Configurable through Tools-=0ptions-=MPLAB Harmony)

Launch I [ cancel

7. Select “Launch”
SEdI N HEesuILs uuLpuL s |

|

f Launching MPLAB® Harmony Configurator
Path: C:\MASTERs\23075\h3%

Generating Configuration Database

e |

The first time the MHC is started, it can take up to 2 Minutes before the Configuration Database is prepared

10
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8. In the next window the H3 parts and their used Version Numbers are displayed

2 Configuration Database Setup

[

Select and configure the packages that will be included in the current project:

Load  Mame Version Dependencies

| |bsp v3.3.0 csp(3.2.1)

V| |core v3.2.1 csp(3.2.1)

V| |crypto v3.2.1 core(v3.2.1)

csp v3.2.1

] Inet v3.3.0 core(3.2.1), csp(3.2.1), dev_packs(...
Configure Device Family and CMSIS Pack Paths:
DFP: .\dev_packs\Microchip\SAME70_DFP\4.0.26\same70b\atdf\ATSAME70Q21B. atdf D
CMSIS: JAdev_packs\arm\CMSIS\5.4.0 D

Launch ] [ Cancel ]

Click on “Launch”

9. Open the saved state file

Z' Open Default Saved State

Open default saved state file?

C:\MASTERs\23075\lab1\firmware\src\configisam_e70_xult_freertos\sam_e70_xult_freertos.xml

Ex=

i Open | [ Cancel

11
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12

10. The MHC is up and running

2 MPLAB Harmony Configurator - sam_e/0_Xult_ireertos

E=mEol A ]

ile Generate Tools Utilities Window
) 3 ) | sipes) Framework: C:\MASTERs\23075\h3\
( Available Components = & 5| |0 Project €raph =9 8| [ Configuration Options =8
+ X omEmm !
Board Support Packages (BSPs)
Harmony Presentation Layer !

. . 4 o]
Libraries TIME netpres
Packs Systam Service S ey Instances —=—)
Peripherals TCO © Core service O ERLIERE Instance 0
Third Party Libraries Peripheral Library SYS_TIME © LIB_CRYPTO LIB_CRYPTO
Tools

SAM E70 Xplained Ultra BSP.

= Paripheral Library

Harmony Core Service

Peripheral Library
MEMORY

(] Available Components | (] Active Companents |

(] Consolle 4 =7

CONSOLE
USARTL Systam Servica.

DRV_MEDIA DRV_MEDIA

SYS_FS

TWIHSO
Peripharal Library
12¢

(] Help (] Configuration Options

Helcome to the MPLAB Harmony Configurator!

11. Select Active Components (left below)

(] Available Components | (| Active Components

| (1 console =4 &
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12. Select the Instance 0 in Active Components

[] Active Components = @ &
X CRER4+

-~ CMSIS Pack

- CONSQLE

- Core

-~ Cryptographic (Crypto) Library
~ FILE SYSTEM

- FreeRTOS

H MEMORY

- Presentation Layer

- SAM E70 Xplained Ultra BSP
- System

= TCP/IP STACK

-- APPLICATION LAYER

=3 BASIC CONFIGURATION

~ TCP/IP Basic Configurator
~ TCPIP CMD
~ TCPIP CORE
~ TCPIP File System Wrapper
= DRIVER LAYER
- NETWORK LAYER
F- TRANSPORT LAYER
~TIME

13. And change in the Configuration Options (on the right side) the Host Name to something meaningful for you.

The Host name can be identified in the Network.

{1 Configuration Options = & 5
=
EHMETCOMFIG
- Metwork Configurations Index =
- Interface GMAC
~Host Name MARTIN_RUPPERT
- Mac Address 00:04:25:1C:A0:02
~IPw4 Static Address 192.168.100.11
- IPy4 SubMNet Mask 255.255.255.0
- IPw4 Default Gateway Address 192.168.100.1
- IPw4 Primary DNS 192.168.100.1
- IPw4 Secondary DMS 0.0.0.0
- Power Mode full
- Network Configuration Start-up Flags
- MWetwaork MAC Driver DRV_GMAC_Object

13
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14. Select “TCP/IP Application Layer Configuration” in Active Components

[] Active Components =B

X omERm4e

- CMSIS Pack

- CONSOLE

- Cryptographic (Crypto) Library
EFC

- FILE SYSTEM

- FreeRTOS

MEMORY

Presentation Layer

-~ SAM E70 Xplained Ultra BSP

~ System

- TCP/IP STACK

= APPLICATION LAYER

----- ANNOUNCE

----- DHCP CLIENT

----- DNS CLIENT

----- HTTPNET SERVER

o B e
th- it

il
Ut

- BASIC CONFIGURATION
#- DRIVER LAYER

H- NETWORK LAYER

#- TRANSPORT LAYER

- TTME

15. Ensure that ANNOUNCE and IPERF are selected

{1 Configuration Options

SR

B} To0A0 Anelicotion | svar Configurator

[ ANNOUNCE l

~Berkeley API ™
- DDNS O
- DHCP CLIENT
~DHCP SERVER ]
- DMS CLIENT
- DMS SERVER. O
- FTP SERVER =
- HTTPMET SERVER
-~ HTTP SERVER [
- REBOOT O
- SMTR CLIENT
- SHMP 0
- SNMPY3 O
-~ SNTR
~TELNET 0
~TFTR CLIENT |
-~ TFTP SERVER 0
- ZEROCONF 0

14
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16. Select ICMPv4 in the Active Components

(] Active Components =3
X omReER4+
""" CMSIS Pack
""" CONSOLE

----- Cryptographic (Crypto) Library
..... EFC

----- FILE SYSTEM

----- FreeRTOS

#H- MEMORY

# Presentation Layer

----- SAM E70 Xplained Ultra BSP

- TCP/IP STACK

- APPLICATION LAYER

- BASIC CONFIGURATION
#- DRIVER LAYER

- NETWORK LAYER

----- TCP/IP Network Layer Configurator
#- TRANSPORT LAYER

----- TWIHSO
----- USART1

17. And ensure that the “Use ICMPv4 Client” is selected

(] Configuration Options
(=] &
E-ICMPy 4
"USE ICMPy4 Server
5-Use ICMPv4 Client
?----Enable Lzer Motification
?----Echu request timeout - ms s00
-~ 1CMP task rate - ms 33

A |||

15
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18. Select “Code” (Generate Code)

= MPLAB Harmony Contigurator - sam_g/l

‘Ile Generate Togle Hilitiac Window

("1 Active Comnonents
19. Select Don’t Save

“Z Modified Configuration

Current configuration has been modified. Do you want to save it before file generation?

[ DontSave | [

Save As

20. Select Generate

-2 Generate Project

EX=

1. Configure Generation Settings

[=l Generate Settings
Merge Strategy

[ USER RECENT

>|[@)

(Mouse over a property for detailed help)

2. View Warnings

Type

Description

3. Click Generate

Cancel

Generate ‘ l
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21. Some Files will be changed and the MHC is asking in a “diff” window, if the changes should be taken over.

22

23

Accept all changes in the file by clicking on the Arrow in the middle above.

2 Merging: configuration.h_8107676870428926504.0ld

/*** tepip cmd Configuration **+/

Pending Merge Actions: 2 4 Previoug
Note: The content of the right pane displays the current state of this merge.
Generated Code Current File: configuration.h_8107676670428926504.0ld
#define TCPIP IPV6 _NDP MAX NEIGHBOR ADVERTISEMENT 3 33 #define TCPIP IPV6 NDP MAX NEIGHBOR ADVERTISEMENT 3 i
#define TCPIP IPV6_NDP REACHABLE TIME 30 "33"‘/ #define TCPIP IPV6 _NDP REACHABLE TIME 30
#define ICPIP IPV6 NDP RETRANS TIMER 1 334  $define ICPIP IPV6 NDP_RETRANS TIMER 1
#dsfine ICPIP IPV6 NDP DELAY FIRST_PROBE_TIME B 335 $aefine ICPIP 1PV NDP DELAY FIRST PROBE_TIME B
#define TCPIP IPV6 NDP VALID_ LIFETIME TWO HOURS (60 * 60 = 2) 336 #define ICPIP IPV6 NDP_VALID LIFETIME TWC_HOURS (60 * 60 * 2)
$define ICPIP IPV6 MIU INCREASE TIMEOUT 600 337 $aefine ICPIP 1PV MTU INCREASE TIMEOUT 600
#define ICPIP IPV6 NDP TASK_TIMER RATE 32 338 $aefine ICPIP IPV6 NDP TASK TIMER RATE 32
339
340
/* Wetwork Configuration Index 0 #/ 341 /* Network Configuration Index 0 %/
#define ICPIP NETWORK DEFAULT INTERFACE NAME IDXO  "GMACT 342 $gefine ICPIP NETWORK_DEFAULT_INTERFACE NAME IDXO  "GMAC"
#asfine ICPIP IF GMAC 343 $define ICPIP IF GMAC
344
Fdefine TCPIP NETWORK DEFAULT HOST NAME IDXO "MARTIN RUBPERT" 345 3define TCPIP NETWORK DEFAULT HOSI NAME IDX0 "MCHPBORRD C"
$define ICPIP NETWORK DEFAULT MAC ADDR_IDXO "00:04:25:1C:A0:02" 346  $define ICPIP NETWORK_DEFAULT MAC ADDR IDXO "00:04:25:1C:A0:02"
347
$asfine ICPIP DEFAULT_IP ADDRESS_IDXO "192.168.100.11" 348 $gefine ICPIP NETWORK_DEFAULT_IP_ADDRESS_IDXO "192.168.100.11"
$asfine ICPIP DEFAULT_IP MASK IDXO "255.255.255. 0" 348 $gefine ICPIP NETWORK_DEFAULT_IP MASK IDXO w255,
$asfine ICPIP DEFAULT_GATEWAY_IDXO "192.168.100.1" 350 $aefine ICPIP NETWORK_DEFAULT_GATEWAY IDXO 192.168.100.1"
#dsfine ICPIP NETWORK DEFAULT DNS_IDXO "192.168.100.1" 351 $aefine ICPIP NETWORK_DEFAULT_DNS IDXO 192.168.100.1"
$asfine ICPIP DEFAULT_SECOND_DNS_IDXO "0.0.0.0" 352 $aefine ICPIP NETWORK_DEFAULT_SECOND DNS_IDXO "0.0.0.07
$asfine ICPIP DEFAULT_POWER_MODE_IDXO meul1n 353 $aefine ICPIP NETWORK DEFAULT_POWER MCDE_IDXO (e
$asfine ICPIP DEFAULT_INTERFACE FLAGS_IDKO \ 354 $define ICPIP NETWORK DEFAULT INTERFACE_FLAGS IDXO \
TCPIP NETWORK_CONEIG DHCP CLTENT ON |\ I TCPIP NETWORK CONFIG DHCP CLIENT ON |\
CONEIG DNS CLIENT ON |\ 356 TCPIP NETWORK CONFIG DNS CLIENT ON |\
CONEIG 1P STATIC 357 TCPIP NETWORK CONEIG IP STATIC
3se
#define ICPIP NETWORK DEFAULT MAC DRIVER IDXO DRV GMAC Object 358 $aefine ICPIP NETWORK_DEFAULT MAC DRIVER IDXO DRV_GMAC Object

/*** tepip cmd Configuration ~**/

#define ICPIP 364 #define ICPIP COMMAND_ENABLE
#define TCPIP ECHO_REQUESTS 4 365 $define TCPIP ICMP ECHO REQUESTS a
#define TCPIP ECHO_REQUEST_DELAY 1000 366 #define ICPIP ICMP ECHO REQUEST DELAY 1000
#define ICPIP ECHO_TTMEOUT 5000 367 4define ICPIP ICMP ECHO_TIMECUT 5000
#define TCPIP ENABLE false 368 $define ICPIP WIFI ENABLE false
#define TCPIP ECHO_REQUEST_BUFF_SIZE 2000 369  #define ICPIP ICMP ECHO REQUEST BUFF _SIZE 2000
#define TCPIP ECHO_REQUEST_DATA_SIZE 100 370 #define ICPIP ICMP ECHO REQUEST DATA SIZE 100
an
a2 |a72 o
|52 |
pane displays the current state of this merge.
.old
-
FG RMII | \
2 Merging: tcpip_private.h_5816637879687640463.0ld ===
Pending Merge Actions: 1 4 Previoug Close
Mote: The content of the right pane displays the current state of this merge.
Generated Code 1 Current File: tcpip_private.h_5816637879687640463.0ld
// private stack ters M e
A R "/ “:qsf S eein b 24 // private stack manager incerface -
Fineiude Topip/sre/tepip manager cemexel.n o 85 |finclude "topip/src/topip manager control.h"
26
lude "z tepip_an o a7
[#1oclude °pip/sre/tepip announce manager.n 97 #include "tcpip/src/tcpip_announce manager.h"
#include "tcpip/ere/ndp manager.n" os B - -
T 98  #include "tcpip/src/ndp manager.h"
#include "tcpip/ere/ipv4 manager.h" EL) B —
B — 98  #include "topip/src/ipv4_manager.h”
#include "tcpip/ere/ipvé manager.h" 100 N B -
A - 100 #include "topip/src/ipvé_manager.h”
#include "tcpip/ere/iempvé manager.n" 101 N B -
- 101 #include "tcpip/src/icmpvé_manager
#include "tcpip/ere/dhepvé manager.n” 102 B —
N - 102 #include "tcpip/src/dhcpvé_manager
#include "tcpip/ere/iemp manager.h® 103 B —
- 103 #include "tepip/src/icmp_manager.h"
#include "tcpip/erc/dhcp manager.h® 104 N B -
- 104 #include "topip/src/dhcp_manager.h”
#include "tcpip/ere/arp manager.n" 1085 N B -
- 105 #include "tcpip/src/arp_manager.h"
#include "tcpip/erc/dns manager.n" 106 B —
- 106 #include "tcpip/src/dns_manager.h"
#include "tcpip/sre/tep manager.n" 107 B —
- 107 #include "tcpip/src/tcp_manager.h"
#include "tcpip/ere/nbns manager.h® 108 N B —
- 108 #include "tcpip/src/nbns_manager.h"
#include "tcpip/sre/http net manager.hn 109 N B -
- — 109 |#include "tcpip/src/http_net_manager.h"
#include "tcpip/ere/tepip commands manager.hn 110 B -
- - 110 |#include "tcpip/szc/tcpip_commands_manager.h"
#include "tcpip/ere/udp manager.n" 111 B - -
- 111 #include "tcpip/src/udp manager.h"
#include "tcpip/ere/sntp manager.h® 112 N B —
- 112 #include "tcpip/src/sntp_manager.h"
#include "tcpip/sre/lldp manager.h" 113 N B -
- 113 #include "tcpip/src/lldp manager.h"
4include "tcpip/src/iperf manager.n" =» 114 =
114 #include "tcpip/src/smtpc_manager.h"
#include "tcpip/src/smtpe manager.n™ 115 B -
T 115 #include "tcpip/src/tcpip_packet.
#include "tcpip/ere/tepip packet.h" 116 N B -
Bl 116 |#include "tcpip/szc/tcpip_helpers_private.h"
#include "tcpip/sre/tepip helpers private.n" 117 N B -
- = 117 #include "tcpip/src/oahash.h”
#include "tcpip/sre/oahash.h" 118 B
118 #include "tcpip/src/hash_fav.h"
#include "tcpip/ere/hash_fnv.h" 119 B =
= R 119 |finclude "topip/src/tcpip_notify.h"
#include "tcpip/sre/tepip_notify.h" 120 e -
121
- ~ 121  fendif // TCPIP_STACK PRIVATE H
#endif // _ TCPIP_STACK PRIVATE H__ 122 e — = - -
123

17
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24. The whole process is displayed with a progress bar

2 Generating Project...

Task Type Remaining Total
File Markup

482

File Copy

w

482

Libraries

Settings

(=1 =11 0=]

Source Paths

Generating file: C:\MASTERs\23075\h3\crypto\src\des3.c

94% Please Wait...

25. Back again in the main window of MPLABX, click on the “Make and Program Device” button

freertos_labl : sam_e70_xult_freertos

tion Debug Teary

=|[ Start Page =9 MPLAB X Store

MLl Bnards

26. After successful build, the SAME70 is programmed automatically

Search Results |0utput " |

b | EDBG i | Kits 2 | web_net_server_nvm_mpfs_freertos_labl (Build, Load, ...} =

LA T L& ]| = LITa Y Ly WLl T L Y b om f LLCAR? L ALLWD S e T A LR L L L LLWER L T oAl

make[l]: Leaving directory 'C:/MASTERs/23075/labl/firmware/san

BUILD SUCCESSFUL (total time: 35s)

[Loading code from C:/MASTERs/23075/1labl/firmware/sam e70 xult_
ction/sam 70 mxult freertos.X.production.hex...

Loading completed

Connecting to programmer. ..
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27. The programming take about 30 seconds with on Board DebuggeCheck whether the USER_LEDO Activity is Blinking

Figure 1. SAM E70 Xplained Ultra Evaluation Kit with PHY Daughter Board

/Z

USER_LEDO™
Activitiy Blinking

4

PEERLELE)

Reset
Button
o
A——’
SWD = : 4
JTAG Adaptor 1 .0
R
Features
* ATSAME70Q21 Microcontroller
Aufsteckbarer
* One Mechanical Reset Button Click Board PHY
» One Mechanical User Push Button Adaptor Daughter
* Two UserLEDs Board Adaptor

* 12.0 MHz Oscillator (DSC6003)

» 32.768 kHz Oscillator (DSC6083)

+ 2-MB SDRAM

* 4-MB QSPI Flash (SST26VF032BA)

19
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Tera Term

28. Open Terra Term Terminal Program and select under Setup->Serial Port the COM Port (in this case a

COMB96, but could be a different COM Port number in your case).

The press the Reset Button of the Board and let the Firmware restart. You should see the start message with the Lab
name and the build timestamp at first, followed by the MAC Address from EEPROM.
29. After some small time, the IP Address should be change from 0.0.0.0 to a valid address

¥ COMY6:115200baud - Tera Term VT =N ECE =™

File Edit Setup Control Window Help

web_net_server_nvm_mpfs_freertos_labl Jun 3 2019 19:30:87
SYS_Initialize: The MPFS2 File System is mounted
MAC TCPIP_HOSTS_CONFIGURATIONIA].macAddr: fc:c?:3d:0c:20:44
TCP/IP Stack: Initialization Started
TCP/IP Stack: Initialization Ended - success

Interface GHMAC on host MARTIN_RUPPERT - NBMNS enabled
GMAC IP Address: 0.0.0.0
EHHC IP Address: 192.168.8.17

4 [

20
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30. To check the basic information about the network enter the netinfo command and press .

4 COM93:115200baud - Tera Term VT

File Edit Setup Control Window Help

>netinfo

—————————— Interface <eth®/GMAC> ———————

Host Mame: MARTIN RUPPERT - MBHNS enabled

IPvh Address: 192.168.0.24

Mask: 255.250.250.0

Gateway: 192.168.8.1

DNS: 192.168.8.1

MAC Address: fc:c2:3d:0b:bf: 9

IPv6 Unicast addresses:
fe80:0:0:0:fec?2:3dff:febBb:bff9
2a02:908:1d41:d520: fec?: 3dff: felBb:bff9

IPv6 Multicast addresses:
ff02:0:0:0:0:1:FffBb:bff9
ff02:0:0:0:0:0:0:1

dhecp 1s ON

Link 1s UP

Status: Ready

>

21
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31. A help shows the available commands

Eile

4 COM93:115200baud - Tera Term VT

Edit Setup Control Window Help

B B

3 B B

B B

B B

¥

3 B B

B B

B B

¥

3 B B

B B

B B

¥

3 B B

B B

B B

¥

3 B B

-- Supported command groups —————-
1perf: 1perf commands ===

tcpip: stack commands ==

————— Built in commands —————-—
reset: Reset host ===

q: quit command processor ===
help: help ===

>help tcpip

netinfo: Get network information ==
defnet: Set/Get default interface ===
dhcp: DHCP client commands =x=
dhcps: Turn DHCP server onfoff =x=
zcll: Turn ZCLL on/off ===

setdns: Set DNS address s===

setip: Set IP address and mask =x=
setgw: Set Gateway address ===
sethbios: Set host’'s NetBIOS name ==
setmac: Set MAC address w===

1f: Bring an interface up/down ===
stack: Stack turn on/off s
heapinfo: Check heap status ===
ping: Ping an IP address s==x

arp: ARP commands ===

dnsc: DNS client commands ===
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32. As a first simple test you can ping an external Server or anything else you like (Maybe the board of your class neighbor?)

X COM96:115200baud - Tera Term VT
File Edit Setup Control Window Help

=N BoR ==

web_net_server_nvm_mpfs_freertos_labl Jun 3 2019 19:30:07
SYS_Initialize: The MPFS2 File System is mounted
MAC TCPIP_HOSTS_CONFIGURATIONIO].macAddr: fc:c2:3d:0c:20:44
TCP/IP Stack: Initialization Started
TCP/IP Stack: Initialization Ended - success

Interface GMAC on host MARTIN_RUPPERT - NBNS enabled
GMAC IP Address: 0.0.0.0
GMAC TP Address: 192.168.0.17

>ping www.google.com
Ping: resolving host: www.google.com
>Ping: replyll] from 172.217.23.132: time = 2oms

Ping: replyl2] from 172.217.23.132: time = 26ms
Ping: replyl3] from 172.217.23.132: time = 2oms
Ping: replyl&] from 172.217.23.132: time = 2oms

Ping: done. Sent & requests, received 4 replies.

4 |1
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33. Select the tcpip_discoverer tool from

E=RIEoE ==

@Ov| » Computer » System (C:) » MASTERs » 23075 » h3 » net » utilities » tcpip_discoverer »

Include in library -

Organize ~

MASTERs

23075
h3
7 bsp
CMSIS-FreeRTOS
core
crypto
csp

dev_packs
mhe
net
Tapps
config

doc

m

docs
driver
net_pres
sys_adapter
tcpip
templates
T mibZbib

mnfs_oeneratar

[_ tcpip_discoverer ]

i
web_pages
wolfssl
Lab_Manuals

labl b

2 items

Share with =

Burn

MName

S

( [ tcpip_discoverer]

Mew folder

-

Date modified

02.06.2019 18:27
02.06.2019 18:27

I

- | +y | | Searcht.. P l

=- O @
Type
File folder

Executable Jar File
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34. If Windows is asking for permissions allow the access

ﬂ Windows Security

program

private networks.

What are the risks of a

Alert

Windows Firewall has blocked some features ofi’_his

Windows Firewall has blocked some features of Java(TM) Platform SE binary on all public and

Name: ava(TM) Platform SE binal

«
=2
Lij Fublisher: Oracle Corporation

Path:

Allow Java(TM) Platform SE binary to communicate on these networks:

Private networks, such as my home or work network

DPuinc networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

llowing a program through a firewall?

C:\program files\java\jrel.8.0_121\bin\javaw.exe

=

“ Allow access ] [ Cancel

35. The TCP Discover should list all boards in the classroom. We have made this tool to help you to find your board in the

network. The source codes of this tool (Java) are part of the H3.

You can identify your board by the Host Name that has select in an earlier step. The Host Name is also known to the

DHCP server and is listed in their typical Web Interfaces as a connected device.

2 Microchip TCPIP Discoverer

Discover Devices | [ | Metwork Direct Broadcast ’ Exit I

. Microchip
= . Harmo
=0 MA

&

Devices

ny
C-Address - fo:c2:3d:0c:20:44

, MAC-Type

am —RAA

. Hostname
- # MARTIN_ RUPPERT

IP Addresses
# 192.168.0.17

# ff02:0:0:0:0:1:ff0c:2044
# ff02:0:0:0:0:0:0:1

# fed0:0:0:0:fec2:3dff:feldc:2044
- # 2a02:908:1d41:d520:fec2:3dff:felc: 2044
J Multicast Listeners

Date - Nov.12 2018
Version - TCPIP Discoverer 3.0

Press the IDiscover Devicesl button: The tool will send a UDP broadcast on port 30303, with the packet “Discovery,

who is out there?” All H3 devices running the Announce service will respond to this broadcast, by sending a return

broadcast on port 30303. The broadcast packet contains data on the type of interface used, the Host Name, MAC and IP

Address. The Discover tool listens to all broadcasts on port 30303 and will show found devices under the Microchip

25
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Devices tree. You can identify your device by looking for the host name that you entered in MHC Setup process. The

Microchip TCPIP Discoverer tool also shows the IP address for your board.

36. A double click on the MAC-Address line will put you in your default Internet Browser

2" Microchip TCPIP Discoverer = | [=] |[é]

’ Discover Devices ] || network Direct Broadcast [ Exit I

.. Microchip Devices
[= ) Harmon
=R MAC-Address - fo:c2:3d:0c:20:44
[=F | MAC-Type
| Lo GMAC
=} . Hostname
L@ MARTIN_RUPPERT
=} IP Addresses
-# 192.168.0.17
% fe80:0:0:0:fec2;3dff:felc:2044
¢ te# 2a02:908:1d41:d520:fec?:3dff:fe0c: 2044
=} ) Multicast Listeners
& ff02:0:0:0:0:1:ff0c:2044
“o 4 ff02:0:0:0:0:0:0:1

Date - Nov.12 2018
Version - TCPIP Discoverer 3.0

37. And the Webpage is displayed. Please take some time an play with the sub menus to find out the capabilities of or H3

Web Server

@ Microchip TCP/IP Stack Demo A1 X =

t secure | 192.1680.17 * 0 %@ e« 06

HARMONY
.

TCP/IP Stack Demo Application

EZZ welcome!

LED:
Dynamic Variables )
e Stack Version: 7.32-H3.2
SSI Processing i 3 Jun 3 2019 Buttons:
Build Date: 19:29:58 A AL
Processing Forms {::aiiv::fm FLASH Ruhdom Ninibes
S 3 47152

Authentication File System Type:  MPFS2

Cookies This site demonstrates the power, flexibility,
e 2Nl scalability of a 32-bit embedded web server. Everything you see is
Uploading Files powered by a Microchip PIC microcontroller running the Harmony Microchip

TCP/1P Stack.

Sending Emails

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
buttons (except MCLR!) and you'll see the status update immediately. This
Network examples uses AJAX techniques to provide real-time feedback.
Configuration
SNMP
Configuration « Dynamic Variable itution - display real-time data

+ Server Side Includes - process real-time SSI commands

« Processing Forms - handle input from the client

« Authentication - require a user name and password

« Cookies - store session state information for richer applications
« Uploading Files - parse files for configuration settings and more

This site is provided as a tutorial for the various features of the HTTP web
server, including:

Several example applications are also provided for updating configuration
parameters, sending emails, and controlling the Dynamic DNS client. Thanks
to built-in GZIP compression support, all these tutorials and examples fit in
the 32kB of on-board Memory.

For more information on the Harmony TCP/IP Stack, please refer to the
TCP/IP Stack Libraries Help paragraph in the MPLAB Harmony Help installed
on your computer as part of the Harmony distribution.

37. Congratulations, you have completed Lab 1!

26




23075 10T6 Simplifying TCP/IP Applications with MPLAB® Harmony

Lab 2

Overview

In many loT applications, JSON is commonly used as a format in order to transport high-level data in an effective way. It is generally
an alternative to XML. Consider the following example of describing a person named Raji-Niklas Ruppert in JSON-format:
{
“firstName” : “Raji-Niklas”,
“lastName” : “Ruppert”,
“age” : 30,
“address” : {
“streetAddress” : “2355 W Chandler Blvd”,
“city” : “Chandler”,
“state” : “AZ”,
“postalCode” : “85224”,

}

Using this format makes it very easy to communicate between applications requiring information about Raji-Niklas Ruppert.

The advantage of using JSON in embedded applications is that because it is easy to read for humans, it is simple to parse and make
use of. Due to this, it is commonly used to transmit data between a server and a web application. In this lab we are going to
implement an embedded application fetching weather data from a web server. When the application accesses a specific URL
specifying a command with a geographic location, the web server will respond by sending the current weather in JSON-format to
the web application. The application will be running on our SAME70-boards.

In this lab we will only do very simple parsing (which is one of the strengths using JSON), using standard string operations. There
are however more sophisticated parsers which can be used for more robust and complex applications, while still only consuming a
very limited footprint.

The weather service used in this lab is https://openweathermap.org/. With OpenWeatherMap, there are several services such as

hourly forecast, UV Index, Air pollution and more, all outputting in JSON. With the free account there are limited option to only use
the “Current Weather Data” service. With this service you can request the current weather from different geographic locations.
Depending on by which method (City ID, ZIP Code, Coordinates etc.) the URL call will be slightly different. A full description of the

API can be found here: https://openweathermap.org/current. For this lab we will fetch current weather by city. The following URL

for this is:

27
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http://api.openweathermap.org/data/2.5/weather?q={CITY}&APPID={API Key}

The API Key is unique to each user. This is also how OpenWeatherMap tracks how many requests you attempt. The API Key is a 15-

byte long hexadecimal string. It can look like this:

ed3da58111974261002c2af4f8e8e81f

In most JSON API:s there is also a well defined format specified, which tells you where the different objects and strings are located

in the JSON-message. From OpenWeatherMap:

28

{"coord":{"lon":-122.09,"1at":37.39},

"sys":{"type":3,"1d":168940, "message":0.0297, "country":"US", "sunrise":1427723751, " "sunset" :14
27768967},

"weather":[{"id":800, "main":"Clear","description":"Sky is Clear","icon":"@1n"}],
"base":"stations",

"main":{"temp":285.68, "humidity":74, "pressure"”:1016.8,"temp_min":284.82, "temp_max":286.48},
"wind":{"speed":0.96, "deg":285.001},

"clouds":{"all":@},

"dt":1427700245,

"id":e,

"name" : "Mountain View",

"cod":200}
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Application Flow

Lab Outline

The pre-made template is built from the Harmony example project, tcpip_tcp_client.

First, we will need to declare the APPID_KEY.

We will then set the host & port of the remote connection static as we will only connect to OpenWeatherMap.

After this, we will redirect the user input from the command console to a char* buffer to be used in the application.

Now we have all information required to build the URL from the introduction.

When we have connected and requested the data, we need to parse the resulting JSON- string (the whole JSON containing
the current weather will be in one string).

Typically, good practice when you debug JSON-strings is to print the resulting string for you to view with your own eyes that
it looks correct.

At last, redirect the application to go back to accepting user input.

29
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Lab Procedure

1. Start by closing any open projects in MPLAB X IDE.

2. Open a new project and choose lab3 -> Firmware -> sam_e70_xult_freertos.X.

3. Open the file app.c located under source files.

4. Go to (CTRL+F) “TODO A”. Enter the correct APPID_KEY. Either you create your own account on OpenWeatherMap or you

take the one written | the class.

37

% \‘ TODC A

39 static const char* APPID KEY = ;
40 char jsonBuffer[l1024]:

41 char cityBuffer[128];

42

43

5. Now scroll down to “TODO B”, the function APP_lInitialize.

6. Set the application to connect to the host api.openweathermap.org and the port to 80. This is set to 80 because this call will
be over HTTP.

105

106 memset (jsonBuffer, 0, sizeof (jsonBuffer)):
107 memset (cityBuffer, 0, sizeof (cityBuffer)):
108

108 appData.host =

110 appData.port =;
111
112 -
113

7. Re-direct the user input from APP_URL_BUFFER to the cityBuffer array. This can be done in several ways, but one is to use

the built-in C function snprintf(char* dest, size_t size, const char *format, ...). The first argument is the destination buffer
(cityBuffer), the second one is the max size to be copied (128, because that is specified in the declaration) and the

formatted input in this scenario is APP_URL_BUFFER. This can be found in “TODO C”".

437 LA UND RLOVLL LTOUlLL,
200 B B
@ TOoDO C
202 snprintf(,,):
203 5Y5 CONSCLE PRINT ( Y i : Es\1 , cityBuffer):
204 B B

8. Scroll down to “TODO D”, the state APP_TCPIP_WAIT_FOR_CONNECTION. In this state we will wait for a connection to be
established. Once established we will send a GET command with the full URL in the format specified in the introduction:

http://api.openweathermap.org/data/2.5/weather?q={CITY}&APPID={API Key}.

277

278 char pathBuffer[128]:

279 snprintf(, 128, data/2.5/weathe T=%= Pl =%3", , ):
g0 appData.path = pathBuffer:

281

9. Once the request is sent to the server, the application will go into the APP_TCIPIP_WAIT_FOR_RESPONSE state.
Once the connection is closed, set the next state to be APP_STATE_JSON_PARSE_RETRIEVED_DATA.
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&z

298 if (!TCPIP_TCP_IsConnected (appData.socket)) {

299 SYS CONSOLE MESSAGE ( > e sed\1 ):s
300 o : Se 1

301 appData.state = ;

302 break;

10. Now go down in the state APP_STATE_JSON_PARSE_RETRIEVED_DATA. One of the first things we want to do after we
have sorted out the JSON-part of the retrieved data is to print the raw JSON-string. This helps us debug & analyse.

313 char* resultingJson;

314 char* pos;

315

316 pos = strstr(jsonBuffer, \ ) ;

317 *(&resultingJdson) = pos;

318

319

320 SYS5 CONSOLE_PRINT ("resul Js AN & ts \r) . )i

11. In areal application, we would need to first know the format of the JSON message in order to be able to parse it correctly.
To make this lab more efficiently, we will do this backwards. If you look on this example piece of APl response from
OpenWeatherMap found in the introduction section to this lab. Looking at the format from the API, we need to calculate
in what position the value of humidity start. The function strstr will cut the resultinglson string at the first occurrence of

“humidity”. A hint is to look at the other blocks where you parse the temperature, pressure and main weather.

322

323 char* mainHumidityJson;

324 char* mainHumidtyBuffer;

325

326

327 pos = strstr (resultingJdson, |

328 * (gmainHumidityJson) = pos + ;

329 mainfdumidcyBuffer = strtok(mainAumidictyJson, )
330

12. Once the parsing is done, we wish to print the values of the main weather, pressure, temperature and humidity.

335 mainMainWeatherBuffer = strtok(mainMainWeatherJson, | H

336

337

338 SYS_CONSOLE_PRINT{ Current Weathe §s ; i %s Pressure: is Temperature: $2.2f Main Weather: %s
339[ AT

340
13. Now to complete the loop, we want to go back to the APP_TCPIP_WAITING_FOR_COMMAND state once the JSON-parsing
and printing is done.

> || 359

360
361

dprl
"I 262
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MPLAB® Harmony TCP/IP Stack
TCP Module API Function List

Socket Management Functions
TCPIP_TCP_ServerOpen Opens a TCP socket as a server.
TCPIP_TCP_ClientOpen Opens a TCP socket as a client.
TCPIP_TCP_Close Disconnects an open socket and destroys the socket handle, releasing the associated resources.
TCPIP_TCP_Connect Connects a client socket.
TCPIP_TCP_Bind Binds a socket to a local address.
TCPIP_TCP_RemoteBind Binds a socket to a remote address.
TCPIP_TCP_IsConnected Determines if a socket has an established connection.
TCPIP_TCP_WasReset Self-clearing semaphore indicating socket reset.
TCPIP_TCP_Disconnect Disconnects an open socket.
TCPIP_TCP_Abort Aborts a connection.
TCPIP_TCP_OptionsGet Allows getting the options for a socket like: current RX/TX buffer size, etc.
TCPIP_TCP_OptionsSet Allows setting options to a socket like adjust RX/TX buffer size, etc.
TCPIP_TCP_SocketinfoGet Obtains information about a currently open socket.
TCPIP_TCP_SocketNetGet Gets the current network interface of an TCP socket.
TCPIP_TCP_SocketNetSet Sets the interface for an TCP socket
e A e G B EL G SIS S Deregisters a previously registered TCP socket signal handler.
TCPIP_TCP_SignalHandlerRegister Registers a TCP socket signal handler.
TCPIP_TCP_Task Standard TCP/IP stack module task function.

Transmit Data Functions

TCPIP_TCP_Put Writes a single byte to a TCP socket.

TCPIP_TCP_PutlIsReady Determines how much free space is available in the TCP TX buffer.
TCPIP_TCP_StringPut Writes a null-terminated string to a TCP socket.

TCPIP_TCP_ArrayPut Writes an array from a buffer to a TCP socket.

TCPIP_TCP_Flush Immediately transmits all pending TX data.

TCPIP_TCP_FifoTxFullGet Determines how many bytes are pending in the TCP TX FIFO.
TCPIP_TCP_FifoTxFreeGet Determines how many bytes are free and could be written in the TCP TX FIFO.

Receive Data Transfer Functions

TCPIP_TCP_ArrayFind Searches for a string in the TCP RX buffer.

TCPIP_TCP_Find Searches for a byte in the TCP RX buffer.

TCPIP_TCP_Get Retrieves a single byte to a TCP socket.

TCPIP_TCP_Peek Peaks at one byte in the TCP RX buffer/FIFO without removing it from the buffer.
TCPIP_TCP_Discard Discards any pending data in the RCP RX FIFO.

TCPIP_TCP_FifoRxFreeGet Determines how many bytes are free in the RX buffer/FIFO.
TCPIP_TCP_FifoSizeAdjust Adjusts the relative sizes of the RX and TX buffers.

TCPIP_TCP_FifoRxFullGet Determines how many bytes are pending in the RX buffer/FIFO.
TCPIP_TCP_GetIsReady Determines how many bytes can be read from the TCP RX buffer.
TCPIP_TCP_ArrayGet Reads an array of data bytes from a TCP socket's RX buffer/FIFO.

TCPIP_TCP_ArrayPeek Reads a specified number of data bytes from the TCP RX buffer/FIFO without removing them from
the buffer.

w
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UDP Module API Function List

Socket Management Functions

TCPIP_UDP_ServerOpen Opens a UDP socket as a server.
TCPIP_UDP_ClientOpen Opens a UDP socket as a client.
TCPIP_UDP_IsOpened Determines if a socket was opened.
TCPIP_UDP_IsConnected Determines if a socket has an established connection.

TCPIP_UDP_Bind Bind a socket to a local address and port. This function is meant for client sockets. It assigns
a specific source address and port for a socket.
TCPIP_UDP_RemoteBind Bind a socket to a remote address This function is meant for server sockets.

TCPIP_UDP_Close Closes a UDP socket and frees the handle.

TCPIP_UDP_OptionsGet Allows getting the options for a socket such as current RX/TX buffer size, etc.
TCPIP_UDP_OptionsSet Allows setting options to a socket like adjust RX/TX buffer size, etc
TCPIP_UDP_SocketinfoGet Returns information about a selected UDP socket.
TCPIP_UDP_SocketNetGet Gets the network interface of an UDP socket

TCPIP_UDP_SocketNetSet Sets the network interface for an UDP socket

TCPIP_UDP_TxOffsetSet Moves the pointer within the TX buffer.

TCPIP_UDP_SourcelPAddressSet Sets the source IP address of a socket

TCPIP_UDP_BcastIPV4AddressSet Sets the broadcast IP address of a socket Allows an UDP socket to send broadcasts.
TCPIP_UDP_DestinationIPAddressSet Sets the destination IP address of a socket

TCPIP_UDP_DestinationPortSet Sets the destination port of a socket

TCPIP_UDP_Disconnect Disconnects a UDP socket and re-initializes it.
TCPIP_UDP_SignalHandlerDeregister Deregisters a previously registered UDP socket signal handler.
TCPIP_UDP_SignalHandlerRegister Registers a UDP socket signal handler.

TCPIP_UDP_Task Standard TCP/IP stack module task function.

Transmit Data Functions

TCPIP_UDP_PutlsReady Determines how many bytes can be written to the UDP socket.
TCPIP_UDP_TxPutlsReady Determines how many bytes can be written to the UDP socket.
TCPIP_UDP_ArrayPut Writes an array of bytes to the UDP socket.
TCPIP_UDP_StringPut Writes a null-terminated string to the UDP socket.
TCPIP_UDP_Put Writes a byte to the UDP socket.

TCPIP_UDP_TxCountGet Returns the amount of bytes written into the UDP socket.
TCPIP_UDP_Flush Transmits all pending data in a UDP socket.
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TCPIP_UDP_GetIsReady Determines how many bytes can be read from the UDP socket.
TCPIP_UDP_ArrayGet Reads an array of bytes from the UDP socket.

TCPIP_UDP_Get Reads a byte from the UDP socket.

TCPIP_UDP_RxOffsetSet Moves the read pointer within the socket RX buffer.
TCPIP_UDP_Discard Discards any remaining RX data from a UDP socket.
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Harmony TCP/IP APl Subset For all Lab’s
TCP Socket Management Functions
TCPIP_TCP_ArrayGet Function

This function reads an array of data bytes from a TCP socket's RX buffer/FIFO. The data is removed from the FIFO in the process.

Function Prototype

uint16_t TCPIP_TCP_ArrayGet (
TCP_SOCKET hTCP,
uint8_t* buffer,
uintle_t 1len

)§

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be read.
buffer Pointer to the array to store data that was read.
len Number of bytes to be read.
Returns
Type Description
uinti6_t The number of bytes read from the socket. If less than 1en, the RX FIFO
buffer became empty or the socket is not connected.

TCPIP_TCP_ClientOpen Function

Provides a unified method for opening TCP client sockets. Sockets are created at the TCP module initialization, and can be
claimed with this function and freed using TCPIP_TCP_Abort or TCPIP_TCP_Close. If the remoteAddress != 0 (and the address

pointed by remoteAddress != 0) then the socket will immediately initiate a connection to the remote host.

Function Prototoype

TCP_SOCKET TCPIP_TCP_ClientOpen (
IP ADDRESS TYPE addType,
TCP_PORT remotePort,
IP MULTI ADDRESS* remoteAddress

)8

Preconditions
TCP is initialized.
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Parameters
Parameter Description
addType The type of address being used. Valid values are: IP_ADDRESS_TYPE_IPV4 or
IP_ADDRESS_TYPE_IPV6
remotePort TCP port to connect to. The local port for client sockets will be automatically
picked by the TCP module.
remoteAddress The remote address to be used
Returns
Type Description
TCP_SOCKET Handle - Save this handle and use it when calling all other TCP APIs. If no
sockets of the specified type were available to be opened, the handle will
contain a value equal to INVALID_SOCKET.

TCPIP_TCP_Close Function
Graceful Option Set: If the graceful option is set for the socket (default), a TCPIP_TCP_Disconnect will be tried. If the linger option
is set (default) the TCPIP_TCP_Disconnect will try to send any queued TX data before issuing FIN. If the FIN send operation fails or

the socket is not connected the abort is generated.

Graceful Option Not Set: If the graceful option is not set, or the previous step could not send the FIN, a TCPIP_TCP_Abort is
called, sending a RST to the remote node. Communication is closed, the socket is no longer valid and the associated resources are

freed.

Function Prototype

void TCPIP_TCP_Close(
TCP_SOCKET hTCP

s

Preconditions
TCP socket should have been opened with TCPIP_TCP_ServerOpen/TCPIP_TCP_ClientOpen.
hTCP - valid socket

Parameters

Parameter Description

hTCP Handle to the socket to disconnect and close.
Returns

Type Description

Void None

TCPIP_TCP_GetlsReady Function

Call this function to determine how many bytes can be read from the TCP RX buffer. If this function returns zero, the application

must return to the main stack loop before continuing in order to wait for more data to arrive.
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Function Prototype

uintl6_t TCPIP_TCP_GetIsReady(
TCP_SOCKET hTCP

)E

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket to check.
Returns
Type Description
uintl6_t The number of bytes available to be read from the TCP RX buffer.

TCPIP_TCP_IsConnected Function

This function determines if a socket has an established connection to a remote node. Call this function after calling

TCPIP_TCP_ServerOpen()/TCPIP_TCP_ClientOpen() to determine when the connection is set up and ready for use.

Function Prototype

bool TCPIP_TCP_IsConnected(
TCP_SOCKET hTCP

s

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The TCP socket to check.
Returns
Type Description
bool True: the socket is connected
False: the socket is disconnected

TCPIP_TCP_PutlsReady Function

Call this function to determine how many bytes can be written to the TCP TX buffer. If this function returns zero, the application

must return to the main stack loop before continuing in order to transmit more data.

Function Prototype

uintl6_t TCPIP_TCP_PutIsReady (
TCP_SOCKET hTCP

g
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Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be written.
Returns
Type Description
uintle_t The number of bytes available to be written in the TCP TX buffer.

TCPIP_TCP_StringPut Function

This function writes a null-terminated string to a TCP socket. The null-terminator is not copied to the socket.

Function Prototype

const uint8_t* TCPIP_TCP_StringPut(
TCP_SOCKET hTCP,
const uint8_t* Data

g

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be written.
const uint8_t* Data
Returns
Type Description
const uint8_t* Pointer to the byte following the last byte written to the socket. If this
pointer does not dereference to a NULL byte, the buffer became full or
the socket is not connected.

TCPIP_TCP_WasReset Function

This function is a self-clearing semaphore indicating whether or not a socket has been disconnected since the previous call. This
function works for all possible disconnections: a call to TCPIP_TCP_Disconnect, a FIN from the remote node, or an
acknowledgment timeout caused by the loss of a network link. It also returns true after the first call to TCPIP_TCP_Initialize.

Applications should use this function to reset their state machines.

Function Prototype

bool TCPIP_TCP_WasReset(
TCP_SOCKET hTCP

g
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Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The TCP socket to check.
Returns
Type Description
bool true: the socket was disconnected since the previous call
false: the socket remained connected since the previous call

UDP Socket Management Functions

TCPIP_UDP_ArrayGet Function

This function reads an array of bytes from the UDP socket, while adjusting the current read pointer and decrementing the
remaining bytes available. TCPIP_UDP_GetlsReady should be used before calling this function to get the number of the available

bytes in the socket.

Function Prototype

uintl6_t TCPIP_UDP_ArrayGet(
UDP_SOCKET hUDP,
uint8 t * cData,
uintl6_t wDatalen

s

Preconditions
UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.
hUDP - valid socket

Parameters
Parameter Description
hUDP UDP Socket Handle
cData The buffer to receive the bytes being read. If NULL, the bytes are simply
discarded
wDatalen Number of bytes to be read from the socket.
Returns
Type Description
uintl6 t The number of bytes successfully read from the UDP buffer. If this value is
less than wDatalen, then the buffer was emptied and no more data is
available.
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TCPIP_UDP_Close Function

Closes a UDP socket and frees the handle. Call this function to release a socket and return it to the pool for use by future

communications.

Function Prototoype

void TCPIP_UDP_Close(
UDP_SOCKET huUDP

)§

Preconditions
UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.
hUDP - valid socket

Parameters

Parameter Description

hUuDP UDP Socket Handle
Returns

Type Description

void None

TCPIP_UDP_GetIsReady Function
This function will return the number of bytes that are available in the specified UDP socket RX buffer. The UDP socket
queues incoming RX packets in an internal queue. If currently there is no RX packet processed (as a result of retrieving all
available bytes with TCPIP_UDP_ArrayGet, for example), this call will advance the RX packet to be processed to the next
queued packet. If a RX packet is currently processed, the call will return the number of bytes left to be read from this
packet.

Function Prototype

uintl6_t TCPIP_UDP_GetIsReady (
UDP_SOCKET hUDP

s

Preconditions
UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.

hUDP parameter is a valid socket

Parameters
Parameter Description
huDP UDP Socket Handle
Returns
Type Description
uintl6 t The number of bytes that can be read from the socket.
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TCPIP_UDP_ServerOpen Function

Provides a unified method for opening UDP server sockets.

Function Prototype

UDP_SOCKET TCPIP_UDP_ServerOpen (
IP_ADDRESS TYPE addType,
UDP PORT 1localPort,
IP MULTI ADDRESS* localAddress

)E

Preconditions
UDP is initialized.

Parameters
Parameter Description
IP _ADDRESS TYPE addType The type of address being used.
IP_ADDRESS_TYPE_IPV4 or IP_ADDRESS_TYPE_IPV6.
UDP_PORT localPort UDP port on which to listen for connections

IP MULTI ADDRESS* localAddress Local IP address to use. Can be 0 (NULL) if any incoming interface will do.

Returns
Type Description
UDP_SOCKET Handle - Save this handle and use it when calling all other UDP APIs. If no

sockets of the specified type were available to be opened, the handle will

contain a value equal to INVALID_SOCKET.

TCPIP_UDP_SocketIinfoGet Function
This function will fill a user passed UDP_SOCKET INFO structure with status of the selected socket

Function Prototype

bool TCPIP_UDP_SocketInfoGet (
UDP_SOCKET huUDP,
UDP_SOCKET INFO* pInfo

s

Preconditions

UDP socket should have been opened with TCPIP_UDP_ServerOpen()/TCPIP_UDP_ClientOpen()().
hUDP - valid socket

pInfo - valid address of a UDP_SOCKET INFO structure

Parameters
Parameter Description
huDP UDP Socket Handle
pinfo Pointer to UDP_SOCKET INFO to receive socket information
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Returns
Type Description
bool true if call succeeded

false if no such socket or invalid pinfo.

UDP_SOCKET_INFO Structure

Holds information about a UDP Socket

Structure

Memb

typedef struct {

IP_ADDRESS TYPE addressType;

IP MULTI ADDRESS remoteIPaddress;

IP MULTI ADDRESS localIPaddress;

IP MULTI ADDRESS sourceIPaddress;

IP MULTI ADDRESS destIPaddress;

UDP_PORT remotePort;
UDP PORT localPort;
TCPIP NET HANDLE hNet;

} UDP_SOCKET_INFO;

ers

Type
IP_ADDRESS_TYPE
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
UDP_PORT
UDP_PORT
TCPIP_NET_HANDLE

Member Name
addressType
remoteIPaddress
localIPaddress
sourceIPaddress
destIPaddress
remotePort
localPort

hNet

Description

address type of the socket
current socket destination address
current socket source address

source address of the last packet
destination address of the last packet
Port number associated with remote node
local port number

associated interface
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